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Disclaimers 
 

• The content of this manual is subject to change without prior notice. 

• The reproduction or transfer of this manual in any form whatsoever is prohibited without the prior written 

permission of the Noise Laboratory Co., Ltd. (NoiseKen). 

• Although every effort has been made to ensure that the content of this manual is accurate and complete, 

please contact NoiseKen if you find any unclear points, errors, omissions, or other inconsistencies. 

• NoiseKen will not be liable for any damages that occur due to improper usage of this product by the 

customer, failure to follow the information in this manual, or repair or modifications performed by a third 

party other than NoiseKen or a party designated by NoiseKen. 

• Regardless of the above, NoiseKen will not be liable for any test results obtained using this product or for its 

effects on the tested equipment. 

• The trademarks and company names appearing in this manual are trademarks or registered trademarks of 

their respective companies. In this manual, the trademark symbol (TM) and registered symbol (R) are 

omitted. 

• Security Export Control System: Requirements for Exporting This NoiseKen Product 

Although this product does not come under rows 1 to 15 of Appended Table 1 of the Export Trade Control 

Order, it comes under the restricted goods catch-all in row 16. For this reason, you must submit an export 

declaration to NoiseKen before exporting this product outside Japan or temporarily taking it outside Japan 

to enable us to conduct a confirmation screening of the final customer, final application, and other details. In 

the provided information, the customer will be requested to confirm that the final destination country, final 

customer, final application, and other details in the export declaration comply with the restrictions in row 16 

of Appended Table 1 of the Export Trade Control Order. 

 

To ensure strict compliance with export control laws, submission of an export declaration is required. Also, 

when reselling the product at a location inside or outside Japan, the repurchaser must also be notified of 

above information. 

 
* Because the above information is based on laws and regulations, it is subject to change due to revisions in the 

applicable laws and regulations. For details on the control and export procedures in laws and regulations, please 

contact the applicable government agency (such as the Ministry of Economy, Trade and Industry; Trade and 

Economic Cooperation Bureau; Trade Control Department; Security Export Control Policy Division). 
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1. Software Licensing Terms 
 

1. Usage Limitations 
Please use the Software for the purposes described in the instruction manuals or the 
specifications. Do not use the Software for purposes other than these. 

 

2. Intended Users 
Please ensure that individuals who use the Software have received the appropriate training and 
practice with regard to the entire system in which the Software runs, including the usage 
environment, equipment safety, and operating methods. 

 

3. Ability to Make Copies 
The Software may be installed and used on multiple personal computers by individuals who are 
members of the business location (factory, branch office, business office, etc.) that purchased the 
Software. 

 

4. Handling of Intellectual Property Rights 
The Software and the intellectual property rights including copyrights for the Software belong to 
NoiseKen. 

 

5. Usage Period 
The usage period designated by NoiseKen shall take effect when the installation of the Software 
or the prescribed procedure for use, whichever is later, has been completed by the Customer, and 
the Customer's right to use the Software shall be deemed to have expired at the end of this usage 
period. 

 

6. Usage Termination Conditions 
If the Customer has violated any of the provisions in this document, or has infringed on the 
copyrights or other intellectual property rights of NoiseKen, NoiseKen shall have the ability to 
revoke the Customer's license to use the Software. 

 

7. Procedures Upon Usage Termination 
The Customer shall promptly uninstall the Software. (If other instructions have been issued by 
NoiseKen, these shall be followed by the Customer.) 

 
8. Disclaimer 

NoiseKen and its dealers and affiliates will not be liable for any customer damages arising from the 
use of this software or for claims of damages by third parties against customers except in the case 
of intentional or gross negligence by NoiseKen, its dealer, or affiliates. 

 
9. Prohibitions 

The following actions are prohibited with regard to the Software. 
(1) Modifications, additions, and other alterations to the functionality of the Software 
(2) Any form of reverse engineering, including decompilation and disassembly, of the Software 
(3) Reselling, transferring, redistributing, licensing, etc. of the Software, or the accessories 

provided by NoiseKen for the Software, to third parties 
(4) Storing the Software, or the information, documentation, and the like provided by NoiseKen for 

the Software, on a network in a state wherein it may be conveyed to a third party 
 
10. Handling of USB and other protection keys 

The software provided by NoiseKen may require USB or other protection keys. 
(1) If a protection key is included in the accessories, the protection key must be mounted in the 

computer where the software is used. 
(2) As a general rule, the protection key is not reissued. In the event that the protection key is 

damaged or lost, please contact the NoiseKen Sales (or Repair) Division. 
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2. IMPORTANT SAFETY PRECAUTIONS 
 
This software performs visualization of electromagnetic field emissions in space. Important 
information for safe operation when performing visualization using this software is provided below, 
and so be sure to read it carefully before use. 
Also, be sure to carefully read this manual and the instruction manual for each device to be used 
before using this software. 
 

1. Incorrect or careless operation could result in a fatal injury. 

2. Avoid use in locations exposed to high humidity and large amounts of dust. 

3. When making connections, electric shock can occur due to contact with the supply 

voltage, and so before performing any connection work, be sure to turn off the power 

to the each device, and check that no power is flowing. 

4. Do not turn off the power to the each device or disconnect any cables while this 

software is running. This could cause PC operation to become unstable or the OS to 

malfunction. Be sure to always exit this software before turning off the power to the 

each device.
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3. Item Check List 
 

Before starting use, check that the parts and accessories below are 
included with the product. 

 

A B C 

 

 
 

D E F 

  

 
G H I J 

 

  

 
 
 A: Web camera 

・ Main part ································································· 1 
・ Warranty ································································· 1 

 B: LAN cable (2 m) ····························································· 1 
 C: USB extension cable (2 m) ··············································· 1 
 D: Setup media (EPS-02Ev3) ·············································· 1 
 E: USB protect key ······························································ 1 
 F: Camera tripod 

・ Main part ································································· 1 
・ Storage bag ····························································· 1 

 G: Extension pole ······························································· 1 
 H: Japanese Quick Start Guide ············································· 1 
 I: English Quick Start Guide ·················································· 1 
 J: Storage case ·································································· 1 
 
* The key of D, E, H and I are included in the upgrade version, and the key of D is disk media. 
* The key of D, H and I are included in the minor upgrade version, and the key of D is disk media. 
* If the software version at the time of purchase is earlier than Ver.3.1.4.0, refer to the instruction 
manual at the time of purchase. 
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4. Introduction 
 

Thank you for purchasing the EPS-02Ev3 Electromagnetic Field Visualization System. 

Before using the EPS-02Ev3, be sure to carefully read this manual to ensure that you 

maximize its performance when operating the EPS-02Ev3. 

 

 This manual is provided to ensure that people who follow the operating procedures and 

safety information can safely use the EPS-02Ev3 and maximize its performance. 

 Place this manual in a location where it is easily accessible whenever operating the 

EPS-02Ev3. 

 

4－1. Features 

 
Enabling visualization of electromagnetic field emissions in space 

 An electromagnetic field measurement sensor is used to perform frequency analysis with a 

spectrum analyzer and to map to the emission location of the actual image. 

 The emission location is mapped relative to the sensor location recognized using the web 

camera. 

 An area of up to 64 blocks × 48 blocks can be measured. 

 A superimposed image of the measurement strength distribution diagram and web camera 

image are displayed for enabling easy identification of the emission source. The density of 

the strength distribution and frequency range can be specified. 

 Measured results can be saved to a file, and the content of the measurement results and file 

can be compared for enabling visualization of the effects of corrective actions. 

 Measurement sensor location detection by hand instead of using a positioner is possible for 

enabling easy measurement in cramped spaces, outdoors, and other difficult-to-access 

locations. 

 

Temporal changes of magnetic field emissions can be displayed. 

 The spectrum analyzer performs frequency analysis of the signals measured by the 

electromagnetic field measurement sensor and displays the data on three dimensions of time, 

frequency, and strength. 

 By detecting the position of the fixed electromagnetic field measurement sensor on the 

camera image, data of temporal changes can be saved in linkage with visualization of 

electromagnetic field emissions in space. 

 

 

 



 

 5 

5. Contents 
 

1. SOFTWARE LICENSING TERMS ............................................................................. 1 

2. IMPORTANT SAFETY PRECAUTIONS ..................................................................... 2 

3. ITEM CHECK LIST ..................................................................................................... 3 

4. INTRODUCTION ........................................................................................................ 4 

4－1.Features ····················································································································· 4 

5. CONTENTS ................................................................................................................ 5 

6. OVERVIEW ................................................................................................................ 9 

6－1.Notation Used in This Guide ···························································································· 9 

6－2.EPS-02Ev3 Features ····································································································· 9 

6－3.Measurement Principle ·································································································· 10 

7. SYSTEM CONFIGURATION DIAGRAM .................................................................. 11 

7－1.System Configuration Diagram ························································································ 11 

7－2.Functions of Each Device ······························································································ 12 

8. PREPARATION ........................................................................................................ 13 

8－1.System Backup ··········································································································· 13 

8－2.System Connections ····································································································· 13 

9. OPERATION PROCEDURE ..................................................................................... 14 

9－1.Starting and Exiting the Software ····················································································· 14 

Starting the Software ............................................................................................................................. 14 

Exiting the Software ............................................................................................................................... 14 

9－2.Image Recognition Settings ···························································································· 15 

Image Recognition Setting Dialog Box .................................................................................................. 15 

Device Name ......................................................................................................................................... 15 

Device Filters ......................................................................................................................................... 16 

Other Settings ........................................................................................................................................ 17 

Image Recognition Setting .................................................................................................................... 18 

9－3.Communication Settings ································································································ 20 

Communication Settings Dialog Box ..................................................................................................... 20 

Equipment Name ................................................................................................................................... 20 

Interface ................................................................................................................................................. 21 

IP Address ............................................................................................................................................. 21 

GP-IB Address ....................................................................................................................................... 21 

Serial Number ........................................................................................................................................ 21 



5.Contents 

 6 

9－4.Option Settings ··········································································································· 22 

Option Settings Dialog Box ................................................................................................................... 22 

Setting Level Excess Notification .......................................................................................................... 22 

Data Acquisition Notification ................................................................................................................. 23 

Functional Limitation ............................................................................................................................. 24 

Display Setting ...................................................................................................................................... 24 

9－5.Help ·························································································································· 25 

9－6.New Measurement (Setting Measurement Conditions) ························································· 26 

View Window ......................................................................................................................................... 26 

New Measurement under the Same Condition ..................................................................................... 27 

Condition Tab ........................................................................................................................................ 28 

Image Division Size ............................................................................................................................... 28 

Capturing ............................................................................................................................................... 29 

Density Display ..................................................................................................................................... 29 

FREE RUN Simultaneous Display ........................................................................................................ 30 

Frequency ............................................................................................................................................. 31 

Spectrum Analyzer ................................................................................................................................ 31 

Antenna Factor ...................................................................................................................................... 32 

9－7.New Measurement (Performing Measurement) ·································································· 33 

Performing Measurement...................................................................................................................... 33 

Deleting Measurement Data ................................................................................................................. 34 

Display Ghost Image ............................................................................................................................. 35 

Highlight Unmeasured Area .................................................................................................................. 37 

Recapturing Camera Image .................................................................................................................. 37 

9－8.Measurement Data Analysis ··························································································· 39 

Measurement Data ................................................................................................................................ 39 

Auto Distribution .................................................................................................................................... 41 

Interpolation .......................................................................................................................................... 41 

Transmittance ....................................................................................................................................... 42 

Image Inversion ..................................................................................................................................... 43 

Display Data Comparison ..................................................................................................................... 44 

Measurement Completion Mark ............................................................................................................ 47 

Frequency Range .................................................................................................................................. 47 

Level Range .......................................................................................................................................... 48 

Unit Switch ............................................................................................................................................ 49 

Frequency Axis Switch .......................................................................................................................... 49 

Map Comment ....................................................................................................................................... 50 

Measurement Information ..................................................................................................................... 52 

Memo .................................................................................................................................................... 52 

Batch Window Settings ......................................................................................................................... 53 

Black and White Inversion .................................................................................................................... 54 



5.Contents 

 7 

Exporting Measurement Data ................................................................................................................ 54 

Coordinate Output Settings ................................................................................................................... 56 

Print........................................................................................................................................................ 57 

Antenna Factor Reloading ..................................................................................................................... 58 

9－9.Spectrogram Measurement (Setting Measurement Conditions) ·············································· 59 

New Measurement ................................................................................................................................. 59 

Condition Tab ........................................................................................................................................ 60 

Measurement Ending Conditions .......................................................................................................... 61 

Specified Sweep Start Interval .............................................................................................................. 61 

9－10.Spectrogram Measurement (Performing Measurement) ······················································ 62 

Performing Measurement ...................................................................................................................... 62 

Messages .............................................................................................................................................. 63 

9－11.Spectrogram Measurement (Measurement Data Analysis) ·················································· 65 

Measurement Data ................................................................................................................................ 65 

Auto Distribution .................................................................................................................................... 68 

Initialization ............................................................................................................................................ 68 

Axis Display Settings ............................................................................................................................. 69 

Display Format ....................................................................................................................................... 71 

Selected Position ................................................................................................................................... 72 

Slider ...................................................................................................................................................... 73 

Select Waveform ................................................................................................................................... 74 

Comparison Target ................................................................................................................................ 74 

Frequency Range .................................................................................................................................. 76 

Level Range ........................................................................................................................................... 77 

Unit Switch ............................................................................................................................................. 78 

Frequency Axis Switch .......................................................................................................................... 78 

Spectrogram Comment .......................................................................................................................... 79 

Batch Window Settings .......................................................................................................................... 81 

Black and White Inversion ..................................................................................................................... 83 

Exporting Measurement Data ................................................................................................................ 83 

Print........................................................................................................................................................ 85 

Antenna Factor Reloading ..................................................................................................................... 86 

9－12.Data Management ······································································································ 87 

Display Items ......................................................................................................................................... 87 

Data Management Settings ................................................................................................................... 88 

10. SETUP ................................................................................................................. 90 

10－1.Important Notes on Setup ···························································································· 90 

10－2.Network Address Settings ···························································································· 90 

10－3.Installing the Software ································································································· 91 

11. ANTENNA FACTOR EDITOR ............................................................................. 92 



5.Contents 

 8 

11－1.Overview ·················································································································· 92 

11－2.Starting and Exiting the Software ··················································································· 92 

Starting the Software ............................................................................................................................. 92 

Exiting the Software .............................................................................................................................. 92 

11－3.Description of the Screen ····························································································· 92 

Entire Screen ........................................................................................................................................ 92 

File Menu .............................................................................................................................................. 93 

Pop-up Menu (Right-Click) .................................................................................................................... 93 

11－4.Operation Procedure ·································································································· 94 

New Measurement ................................................................................................................................ 94 

Open... .................................................................................................................................................. 94 

Import .................................................................................................................................................... 94 

Export .................................................................................................................................................... 94 

11－5.Editing Correction Data ······························································································· 95 

Set frequencies ..................................................................................................................................... 95 

Level correction values ......................................................................................................................... 95 

11－6.Sample Antenna Factor ······························································································· 96 

12. SPECIFICATIONS ............................................................................................... 97 

12－1.System Requirements ································································································· 97 

12－2.Supported Spectrum Analyzers ····················································································· 97 

12－3.Antenna Frequency Characteristics ················································································ 98 

13. WARRANTY ...................................................................................................... 100 

14. NOISE LABORATORY SUPPORT NETWORK ................................................ 103 

 



 

 9 

6. Overview 
 

6－1. Notation Used in This Guide 

 
The marks used in this guide and their meanings are provided below. 

 Provides an additional explanation. 

 Indicates a location for further reference. 

 Indicates a setting restriction. 

 Indicates that you must check before usage. 

【 】 Indicates information inscribed on the panel of this testing device. 

 

6－2. EPS-02Ev3 Features 

 

＊ Measurement sensor is detected from the image for recognizing the measurement 
location 
The measurement object and measurement sensor are captured by a camera, and the 
measurement sensor is found within the image for identifying the measurement location. The 
recognized measurement location is a relative location within the camera image. 
Any user-selected color can be specified for the measurement sensor. However, selecting a 
color with the same tone as the background color will result in a reduced rate of recognition 
and even mistaken recognition in certain cases. 
The measurable range is the area shown in the camera, but it is restricted to a range that can 
be recognized by the measurement sensor. 
 

＊ Automatic control by software 
Measurement sensor recognition from the camera image and control of the spectrum 
analyzer are performed automatically. The measurement results can be output as a CSV file, 
and the image can be output in BMP format. 
 

＊ Visual display of measurement results 
The measurement strength distribution and camera image are displayed as a superimposed 
image on the computer screen. Also, the mouse pointer in the image can be used to confirm 
measurement results for any selected position. 
In addition, an interpolation view of the surrounding strength can be used to provide easier 
assessment of the generation points. 
 

＊ Full emission analysis function for measurement points 
Data can be collected for the entire measurement frequency range generated from the 
measured object in a single measurement. The emission map for each frequency band is 
also redisplayed by simply specifying the frequency band. 
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6－3. Measurement Principle 

 
The EPS-02 system performs two main operations for enabling visualization of the electromagnetic 

field. First, it performs image recognition that identifies the measurement sensor location from the 

recording image. Second, it provides a color-coded distribution on the image indicating the strength of 

the signals detected by the measurement sensor. 

In image recognition, 640 x 480 pixel video from the camera is monitored in real time, and a 

specific color only is extracted based on the specified parameters for "hue", "brightness", and 

"saturation". By finding the focal point of the area with the specific color, the location of the specific 

object (measurement sensor) can be found in the image. 

If an object with the same color as the specified color, but that is not the measurement sensor, 

appears in the image, the measurement sensor location cannot be recognized correctly because the 

focal point of all objects of this color is calculated. Therefore, the parameter settings for "hue", 

"brightness", and "saturation" that are used to detect the measurement sensor, the brightness and 

light exposure in the recording location, and selection of the lighting are important factors. Also, the 

cover of the measurement sensor must be adjusted based on the color of the measurement object. 

Substances suitable for the measurement range are used for the measurement sensor, and a 

spectrum analyzer is used as the measuring instrument for enabling measurement of the 

electromagnetic field area. The spectrum import count and frequency range vary depending on the 

measurement sensor and measuring instrument. The measurement data is mapped to a position 

specified by image recognition. The method of capturing data at the same position can be selected 

from MAX HOLD, MAX PEAK DATA, FREE RUN, and SINGLE. 

After measurement is completed, the frequency range that you want to view can be selected for 

creating a strength distribution combined with the image.  

There are no guidelines or restriction values for the electrical field strength of the proximity field. 
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7. System Configuration Diagram 
 

7－1. System Configuration Diagram 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Web camera 

This captures the image of measurement object. 

② Control PC 

This controls the various devices and conducts electromagnetic field measurement. 

③ Spectrum analyzer 

Support is provided for some spectrum analyzers described in “12－2.Supported Spectrum 

Analyzers” on page 97. Please consult with NoiseKen for use of spectrum analyzers that are not 

supported. 

④ Preamplifier (Optional) 

This is a high-performance preamplifier that can be used for EPS-02 series and other various 

applications. 

⑤ Measurement sensor (Optional) 

The electrical field probe, magnetic field probe, and other measurement sensors are selected 

based on the frequency application. NoiseKen optional probes and commercially-available 

electromagnetic field probes can be used. 

 

USB cable 

① 

④ 
⑤ 

② 

LAN cable 

N(P)－N(P) 

coaxial cable 

③ 

N(P)－BNC(P) 

coaxial cable 
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7－2. Functions of Each Device 

 

① Web camera 

This is a general-purpose web camera. The image of measurement object is captured and 

transferred to the PC. The web camera is connected to the PC by a USB cable. If necessary, the 

connection can be extended by a USB extension cable. 

② Control PC 

This enables running of system control software. This software imports images from the web 

camera, identifies the measurement sensor within the image, and finds its location. After 

frequency analysis is performed by the spectrum analyzer, the control PC receives the 

measurement results and maps them to that location. 

③ Spectrum analyzer 

This performs frequency analysis of the signals from the measurement sensor and sends the 

spectrum data to the PC. The spectrum analyzer is connected to the PC using the supplied GP-IB 

or LAN cable. 

④ Preamplifier (Optional) 

This amplifies the signal detected by the measurement sensor. Connect the measurement sensor 

to the INPUT terminal and the spectrum analyzer to the OUTPUT terminal. 

⑤ Measurement sensor (Optional) 

A sensor (probe) is used based on the measurement target frequency and electrical or magnetic 

field. Attaching a special cover to the sensor is recommended for improving the recognition rate. 
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8. Preparation 
 
 

CAUTION 
Environments having poor signal reception 
In environments exposed to extremely large amounts of external noise, the equipment may be unable 
to realize its maximum performance. 
Even when indoors, the equipment can be affected by lighting and other electronic devices. During 
measurement, try to minimize the effect of the electromagnetic environment to prevent external noise 
from affecting the equipment. Also, certain PCs may generate large amounts of noise emissions and 
may not be suitable for measurement systems. 

 
 

8－1. System Backup 

 

NoiseKen provides an optional service (additional charges apply) for installing the EPS-02Ev3 

program in your PC before providing the program, but if the program is erased, install it from the 

supplied setup media. Copy the content of the setup media to a hard disk, removable disk, or other 

location and store it there in case of loss. For details of setup, see "10. Setup" (P90). 

 

8－2. System Connections 

 

① Connect the web camera to the PC using the USB cable. Any commercially-available USB cable 
can be used, but it must be a cable that supports the USB 2.0 standards. Be aware that the USB 
2.0 standards limit the cables to a maximum of 1 extension and maximum length of 5 m. 

② The spectrum analyzer and PC are connected by a LAN cable. A commercially-available cable 
can be used for the LAN cable. Use a one-to-one local connection without passing through the 
site LAN or hub. 

③ Connect the measurement sensor and spectrum analyzer. Use the proper conversion cable that 
matches the sensor output connector. 
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Screen displayed immediately after the software is started 

9. Operation Procedure 
 

9－1. Starting and Exiting the Software 

 

Starting the Software 
To start the software, double-click the EPS-02Ev3 shortcut icon on the desktop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exiting the Software 
To exit the software, click the close button on the right end of the title bar or click Exit from the File 

menu. 

Because the software cannot be closed during measurement, finish measurement before exiting 

the software. 

 

 

 

 

 

 

 

Double-click 

Click 

Click 
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Image Recognition Setting dialog box 

  

9－2. Image Recognition Settings 

 

Image Recognition Setting Dialog Box 
To open the Image Recognition Setting dialog box, click Image Recognition Setting from the 

Set menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Adjust the camera position so that the measurement object can be captured by the camera. 
Take the following conditions into account during adjustment. Changing camera properties or 
adjusting the lighting may be required depending on the circumstances. 

・Sufficient brightness is provided so that the measurement object and the measurement 

sensor can be fully recognized. 

・There is no object whose color is similar to that of the measurement sensor. 

 

Device Name 
Camera names are displayed in the Device Name list. If multiple cameras are connected, select 

the camera to be used from the device name list. 

 

 

 

 

 

Click 

Select a camera 
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Video Proc Amp screen Camera Control screen 

  

Device Filters 
To open the Webcam Properties dialog box, click the Device Filters button. 

In the dialog box, the camera properties, such as zoom, white balance, and anti flicker, can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 White balance 

White balance is a function to perform color correction so that a white object appears white. If the 

light source, such as sunlight, light bulb, or fluorescent, makes the white object look bluish or 

reddish, adjust white balance. 

 Anti Flicker 

Anti Flicker is a function to reduce flicker in images. 

 Zoom 

Zooming may not be possible depending on the model, driver, or color space / compression 

settings. Refer to “Other Settings” on page 17 for the color space / compression. 

 

 
The Properties screen may vary depending on the model or driver version of the connected 
camera. 

 

  

Click 

Zoom 

Anti Flicker 

White balance 
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Other Settings dialog box 

 

Other Settings 
To open the Other Settings dialog box, click the Other Settings button. 

In the dialog box, the color space / compression and camera processing can be set. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Color Space / Compression 

The color space / compression of the camera can be changed. If the camera is not working 

properly, changing it may improve the situation. The first item in the list is the recommended 

method. 

(2) High speed processing 

Speed up camera processing. If the camera is not working properly, unchecking the checkbox 

may improve the situation. 

  

Click 

(1) 

(2) 
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Image Recognition Setting 
Adjust the three parameters, Hue, Saturation, and Value, in the Image Recognition Setting so 

that the color of the electromagnetic sensor can be recognized. Left-clicking the position of the 

electromagnetic field measurement sensor on the camera image adjusts the hue, saturation, and 

brightness at the clicked position and changes the binarized image. Each left click configures the 

image recognition setting based on the previous image recognition setting and the color 

information of the clicked position. Right-clicking returns the image recognition setting to the 

previous one. 

Clicking the Image Recognition Setting Reset button resets the image recognition setting and the 

information obtained by clicking on the camera image. 

 

 

 

 

 

 

 

 

 

 

 

 

Moving the sliders can also adjust color recognition.  

Hue: Sets the hue, such as red, blue, or yellow 

Saturation: Sets the intensity and purity of a hue 

Value: Sets the lightness of a color. 

 

 

 

 

 

 

  

Click 
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Adjust the parameters until the electromagnetic field measurement sensor is recognized as a circle 

and no other object is recognized. If there is any object whose color is similar to that of the sensor 

in the background, hide the object or change the color of the sensor. 

Once the sensor is recognized as a circle, click OK to complete adjustment. 

 

 

 

 

 

 

 

 

 

 

 

 
Procedure for successful sensor recognition setting 
[Adjustment by clicking on the image] 

1. Left-click the position of the sensor on the camera image. 
2. If there are other recognized areas than the sensor or the sensor is not circular, left-click 

other part of the sensor 
3. Repeat Step 2 until the sensor is correctly recognized. 
4. If the sensor is not correctly recognized after repeating the action several times, click the 

image recognition setting reset button and do the same procedure from step 1 or try 
[Adjustment by sliders] shown below. 

 
[Adjustment by sliders] 

1. Set the Saturation and Value to 0. 
2. Adjust the Hue so that the sensor is most clearly recognized. 
3. Increase the Saturation gradually to remove other recognized areas around the sensor. 

Do not increase the Saturation excessively to prevent the recognized sensor area from 
being impaired. 

4. Increase the Value in the same manner. 
5. Finally, move the sensor outside of the camera view, and make sure that there is no 

object to be recognized.  
If any other object is recognized, repeat steps 3 and 4. 
When the mal-recognition is not solved even if steps 3 and 4 are repeated, start over 
from step 1. 

Desirable recognition state 
The shape of the sensor is almost circular. 
There are no recognized areas in the 
background. 

Not desirable recognition state 
The shape of the sensor is not circular. 
There are recognized areas in the 
background. 
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Communication Settings dialog 

  

9－3. Communication Settings 

 

Communication Settings Dialog Box 
To open the Communication Settings dialog box, click Communication Settings from the Set 

menu. 

In this dialog box, a remote-controlled spectrum analyzer can be set up. 

 

 

 

 

 

 

 

Equipment Name 
Select the equipment name of the connected spectrum analyzer. 

The following nine drivers are available as standard options: FSV, FSV3000, FPL1000, ESR, ESRP, 

MDO4000, N9010A, N9010B, and RSA306B. Customized spectrum analyzer drivers are also 

included in this list. 

 

 

 

 

 
If the Equipment Name list is blank, no spectrum analyzer driver may exist. Check to see that 
spectrum analyzer drivers (*.sad) are stored in the folder where the EPS-02Ev3 executable file is 
stored (C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev3, under normal conditions).  

  

 

 
When NI-VISA (National Instruments) has not been installed, the Equipment Name list is blank 

even if spectrum analyzer drivers exist. In such cases, install NI-VISA according to “10－3. 

Installing the Software” in page 91. 

Click 
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Interface 
Selectable interface types vary depending on the selected equipment. 

Equipment supports GP-IB only, LAN/GP-IB, or LAN/GP-IB/USB. 

 

 

 

 

 

 

 

 

 

IP Address 
The IP Address is displayed when LAN is selected as the interface with the analyzer. 

For how to set the IP address, see “10－2. Network Address Settings” on page 90. 

 

 

 

GP-IB Address 
The GP-IB Address is displayed when GP-IB is selected as the interface with the analyzer. 

Set the address to the same value as the GP-IB address of the selected equipment. 

 

 

 

Serial Number 
The Serial Number is displayed when USB is selected as the interface with the analyzer. 

Check the serial number of the selected equipment using the system confirmation screen for the 

equipment. 

 
 
  



9.Operation Procedure 

 22 

Option Settings dialog 

 

9－4. Option Settings 

 

Option Settings Dialog Box 
To open the Option Settings dialog box, click Option Settings on the Set menu. 

Optional function is set here. 

 

 

 

 

 

 

 

 

 

 

Setting Level Excess Notification 
A function that displays a message or notifies by sound when the setting level is exceeded can be 

set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Use setting level excess notification function 

To enable this function, check the checkbox. 

Click 

(1) 

(2) 

(3) 

(4) 
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Message 

(2) Setting level 

Sets a level. 

(3) Excess notification method 

Specifies the notification method for when the setting level is exceeded. Selecting Message 

display displays a message. Selecting Sound notification notifies by sound. 

(4) Message 

Sets a message to be displayed when the setting level is exceeded. To initialize the message, 

press the Initialize Message button. 

 

 

 

 

 

 

 

 
Setting level excess detection is performed before interpolation by Antenna Factor. 

 

Data Acquisition Notification 
A function that notifies whether the number of data acquisitions of each division has reached the 

set number can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) 

(2) 

(3) 

(4) 

(5) 
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(1) Use data acquisition notification function 

To enable this function, check the checkbox. 

(2) A set number of times 

Sets a set number of times. 

(3) Sound notification of reaching the set number of times 

If the checkbox is checked, reaching the set number of times is notified by sound. A low tone 

will continue to sound in the divisions that have not reached the set number. A high tone will 

sound in the divisions that have reached the set number. 

(4) The division is displayed in gray until the set number of times is reached (only during 

measurement) 

If the checkbox is checked, the divisions that have not reached the set number of times will be 

displayed in gray. After the measurement is completed, the color coding is displayed. 

(5) Data acquisition is not performed after the set number of times is reached 

If the checkbox is checked, data will not be acquired in the divisions that have reached the set 

number of times. 

 

Functional Limitation 
It is possible to set limitation of changing the conditions for new spectrogram measurement. If the 

checkbox is checked, the settings for the frequency, spectrum analyzer, and Antenna Factor in the 

measurement condition tab cannot be changed. Functional limitation can be changed only when 

the window is active before spectrogram measurement. Refer to “Spectrogram Measurement 

(Setting Measurement Conditions)” on page 59 for the spectrogram measurement. 

 

 

 

 
 

Display Setting 
Checking the checkbox displays the pointer position at the top of the graph. The pointer is not 

displayed when the data comparison is displayed. 
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9－5. Help 

The version information, etc. are displayed. 
 
 
 
 
 
 
 
 

(1) About EPS-02Ev3 

The version information of this software is displayed. 

(2) Manual 

The instruction manual of this software is displayed. 

(3) License Information 

The license information is displayed. 

  

(1) 

(2) 

(3) 

(1) 
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View window (before measurement) 

 

9－6. New Measurement (Setting Measurement Conditions) 

 

View Window 
To open a View window, click New Measurement from the File menu or click the New 

Measurement button on the toolbar. 

Whenever a View window is newly opened, it is numbered as follows: View1, View2, View3 ... 

These names can be changed freely when the file is saved after measurement. 

Before starting measurement, set an image division size, properties for the spectrum analyzer, and 

other conditions in the View window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If a web camera or USB protect key is not connected, new measurement is not possible. 

 

  

Click 

Click 
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New Measurement under the Same Condition 
When the View window is active after measurement, click New Measurement under the Same 

Conditions on the File menu or the New Measurement under the Same Conditions button on 

the tool bar to open the View window whose measurement conditions and display settings are 

partly matched. At this time, the communication settings are also changed to the settings in the 

View window after measurement. Use this function to perform measurement using the same 

settings as before. 

 

 

 

 

 

 

 

 

 

 

 

 

The settings that can be used are as follows. 

Menu / Tab Settings 

Set Menu Communication Settings 

Condition Tab 
Image Division Size, Capturing, Frequency, Spectrum Analyzer, 

Antenna Factor 

Map View Tab 
Allocation setting of Intensity Distribution, Image Inversion, Method for 

Comparison 

Graph View Tab Level Range, Unit Switch, Frequency Axis Switch 

 

 
By saving measurement data for frequently used measurement conditions, multiple 
measurement conditions can be used properly. 

  

 
If the same spectrum analyzer driver or antenna factor file does not exist, the settings will not 
be the same. Also, note that the communication settings and spectrum analyzer settings will 
not be the same for data measured with the software versions earlier than EPS-02Ev3. 

 

 

Click 

Click 
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Conditions (before measurement) Conditions (after measurement) 

Image division size: 10 pixels Image division size: 160 pixels 

 

Condition Tab 
In the Condition tab, set the image division size, properties for the spectrum analyzer, and other 

conditions. 

Each item of the measurement conditions can be set only before the measurement except for 

Enable Factor. After measurement, all items except for Enable Factor are displayed but cannot 

be changed. 

 

 

 

 

 

 

 

 

 

 

 

Image Division Size 
Set the division size by which a camera image is divided. 

The image division size can be selected from 10 pixels (H: 64 × V: 48 squares), 16 pixels (H: 40 × 

V: 30 squares), 20 pixels (H: 32 × V: 24 squares), 32 pixels (H: 20 × V: 15 squares), 40 pixels (H: 

16 × V: 12 squares), 80 pixels (H: 8 × V: 6 squares), or 160 pixels (H: 4 × V: 3 squares). 

Select 20 or 32 pixels normally. 
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Capturing 
How to store spectrum data at the same measurement point (the same square of the grid) can be 

selected from SINGLE, FREE RUN, MAX PEAK DATA, or MAX HOLD. 

 

 

 

 

 

 

 

 

 

Density Display 
Selecting Create Density Display generates data required for density display during measurement. 

With this function, the temporal density of signals is represented in colors. On the graph, the 

warmer the color, the more frequently signals appear; the colder the color, the less frequently 

signals appear. 

 

 

 

 

 

Clicking the Set button opens the Density Display Setting dialog box to change the settings for 

the density display. 

 

 

 

 

 

 

 

 

 

 

SINGLE Performs measurement only one time. 

FREE RUN Always overwrites the data. 

MAX PEAK 

DATA 

Compares the maximum values of the 

spectrum waveforms, and overwrites the 

retained value if it is not the largest. 

MAX HOLD 

Compares the maximum values of the 

spectrum waveforms on a point basis, and 

overwrites the retained values if it is not the 

largest. 

Click 

(1) (2) 

(3) 
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FREE RUN Simultaneous Display is checked 

(1) Display 

Selecting All displays the spectrum graph over the density display. Selecting Spectrum 

Graph displays the spectrum graph only. Selecting Density Display displays the density only. 

(2) Color Assignment 

Sets the upper and lower limits for color assignment. Areas above the upper limit are displayed 

in red, and those below the lower limit are displayed in blue. If the upper limit is set to 70%, 

areas with a frequency of 70% or more are displayed in red. 

(3) Data Deletion 

Deletes the density display data when selected. Use this function if the data volume is large. 

However, doing so disables the density display. Data deletion is possible only after 

measurement. 

 

 
In the case of the following settings, the density is not displayed. To enable the density display, 
change the settings. If the Antenna Factor is changed after measurement, the density display 
data is deleted. 
・Frequency Range: Enlarge Specified Range 

・Display Data Comparison 

・Level Range: Specified Level 

・Frequency Axis Switch:Log 

 

 
There may be slight differences between the spectrum graph and the density display because 
their display methods are different. Also, the upper limit of the count used for density 
calculation is 65535 times. If the number of sweeps exceeds the upper limit, the density will be 
displayed higher than it actually is. 

 

FREE RUN Simultaneous Display 
When the FREE RUN Simultaneous Display is checked, the waveform when FREE RUN is 

selected in the Capturing is displayed at the same time. It can be displayed only during MAX 

PEAK DATA or MAX HOLD measurement, and FREE RUN waveform is not saved after 

measurement. 

 

 

 

 

 

 

 

 

 

 

Yellow: MAX HOLD 

Blue: FREE RUN 
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Frequency 
The measurable frequency range depends on the spectrum analyzer and electromagnetic field 

measurement sensor. 

The frequency unit can be selected from Hz, kHz, MHz, and GHz. 

 

 

 

 

Spectrum Analyzer 
To configure advanced settings for the spectrum analyzer, click the Set button next to the 

equipment name of the analyzer to open the Property dialog box. 

For details of each item, refer to the instruction manual for the spectrum analyzer. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Items shown in the Property dialog box may vary depending on the selected spectrum 
analyzer driver. 

 

 
Even for spectrum analyzers that can set the number of sweep points to 60001 points or 
more, the maximum number of sweep points is limited to 60001 points except for the 
RSA306B. 

 

 

Notes for property settings 
 Resolution Bandwidth (RBW) 

The bandwidth of the IF filter. A smaller setting value induce sharper spectrum and 
noise floor level goes down, however sweep time is increased. 

 Video Bandwidth (VBW) 
The bandwidth of the averaging filter. A smaller setting value eliminate noise 
components of signal, however sweep time is increased. 

 Reference Level 
The vertical reference positions of spectrum on screen. Adjust value to fit on the 

Click 
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Antenna Factor Editor Screen 

screen. 
 Attenuator 

An attenuation of input signal. A higher value reduces miss match reflection, and noise 
floor level goes up. 

 

Antenna Factor 
When using Antenna Factor, check Enable Factor and select the file with the same name as the 

electromagnetic field measurement sensor to be used. 

In the initial state after installation, THROUGH is the only available antenna factor. The factor files 

for the electromagnetic field probes (PN7405) are included on the attached setup media. To use 

them, follow the steps below. 

(1) Log into Windows using an ID having administrator privileges. 

(2) Load the attached setup media, and open the FACTOR folder. 

(3) Open the 00-00013A or 00-00019A folder according to your preamplifier. 

(4) Copy the factor files (*.ant) in the folder to the folder where the EPS-02Ev3 executable file is 

located (C:\Program Files (x86)\NoiseKen\EPS-02Ev3, under normal conditions). 

This factor file is used for correction to make the frequency characteristics of the sensor flatness. It 

is not for convert absolute field strength. 

When the THROUGH file is selected or Enable Factor is unchecked, the spectrum data from the 

spectrum analyzer are acquired as it is, without interpolation. 

 

 

 

 

If the original sensor is used, a factor file can be created using Antenna Factor Editor. For details, 

see “11. Antenna Factor Editor” on page 92. 
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9－7. New Measurement (Performing Measurement) 

 

Performing Measurement 
To start measurement, click the START button in the upper right of the View window. During 

measurement, the PAUSE and STOP buttons are enabled. 

To suspend measurement, click the PAUSE button to suspend measurement, and to finish 

measurement, the STOP button. 

After completion of measurement, all buttons are disabled. When performing measurement again, 

click New Measurement from the File menu or click the New Measurement button on the toolbar. 

 

 

 

 

In the Condition tab, only Capturing can be changed. In the Map View tab, only allocation setting 

of Intensity Distribution and Transmittance can be changed. In the Graph View tab, only Unit 

Switch and Frequency Axis Switch can be changed.  

 

Points (squares of the grid) that have been measured are color-coded according to the peak value 

and overlaid on the camera image during measurement. In addition, the spectrum data measured 

by the spectrum analyzer is displayed in the spectrum graph area located in the lower part of the 

View window, on a point-by-point basis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If a directional sensor is used, maintain the same direction. 
In addition, move the sensor parallel to the measurement object. 

During measurement After measurement Before measurement 

START STOP PAUSE 
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Before deleting data After deleting data 

  

The EPS-02Ev3 software sends a sweep start command to the spectrum analyzer immediately 

after the sensor is recognized. After completion of sweeping, the software recognizes the sensor 

position again, and only when the sensor is found at the same point (position) where it was placed 

at the start of the analyzer sweeping, the spectrum data is stored.  

If the sensor is moved quickly, the point at the start of sweeping differs from that at the completion 

of sweeping, and as a result, measurement data is not stored. For spectrum analyzers with slow 

response speed, move the sensor more slowly. 

 

If the sensor is not recognized or other object is falsely recognized, reconfigure the image 

recognition setting. Click Image Recognition Setting from the Set menu to change the setting. 

Please note that it is possible during measurement. 

 

 
Note that if the noise level emitted from the EUT is high, the spectrum analyzer and 
preamplifier may be damaged by excessive input. 

 

Deleting Measurement Data 
Stored measurement data can be deleted on a point-by-point basis. 

When data to be deleted is left-clicked during measurement, the data turns black and the Delete 

menu appears. Also, when the range of data to be deleted is dragged, a black frame appears and 

the data in the frame turns black. If the dragging is canceled in this state, the Delete menu appears. 

Clicking this menu deletes the measurement data displayed in black. 

 

 

 

 

 

 

 

 

 

 

 

 
Data can be deleted only during measurement and cannot be deleted after completion of 
measurement. 
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Map Measurement Spectrogram Measurement 

  

Display Ghost Image 
Past camera images can be overlaid to adjust the position. Use this function to perform 

measurement using the same camera settings as before 

 

 

 

 

 

 

 

 

 

Right click on the camera image before and during the measurement and select Display Ghost 

Image to display the Display Ghost Image dialog box. Select an image to be displayed in Select 

Display Image and click OK to display the selected image in an overlaid manner. Transmittance of 

the overlaid past images can be changed by changing the transmittance of the Map View tab, and 

the image becomes invisible if the transmittance is set to 100%. Refer to “Transmittance” on page 

42 for the transmittance. 
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Forefront is unchecked Forefront is checked 

 

Selectable images to be overlaid are as follows. 

No Display No past image is displayed. 

Specify File 

Select an image to overlay from the files. Selectable images are 

files with the extension “.emg”. The camera image at the end of 

measurement is saved with this extension when the 

measurement data are saved. 

Image at the start of 

measurement 

Selectable only during measurement. The image at the start of 

measurement is overlaid. Use this when a misalignment has 

occurred during measurement. 

Reference Condition Image 

Selectable only in the View window when New Measurement 

under the Same Conditions is selected. The camera image in 

the View window referred to for measurement conditions is 

overlaid. Use this to perform measurement using the same 

settings as before. 

Map Measurement Image 

Selectable only before and during the spectrogram 

measurement. The image at the end of map measurement is 

overlaid. Refer to “Spectrogram Measurement (Setting 

Measurement Conditions)” on page 59 for the spectrogram 

measurement. 

 

In Display Format, the display format of an overlaid image can be changed. Select Vertical 

Inversion or Horizontal Inversion to invert the image vertically or horizontally. Forefront can be 

selected only during measurement. Select this not to display the measured data. Use this when the 

camera image is not visible behind the measured data. 
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Unmeasured area displayed in black 
 

Unmeasured area displayed in white 
 

 

Highlight Unmeasured Area 
Unmeasured areas can be displayed in black and white blinking during measurement. Use this to 

confirm unmeasured image divisions. 

 

 

 

 

 

 

 

 

 

Right click on the camera image during the measurement and select Highlight Unmeasured Area. 

 

 

 

Recapturing Camera Image 
If the STOP button is clicked after completion of measurement, the camera image switches from 

video to still image. If the still camera image includes an unnecessary object, such as the sensor, 

the camera image can be recaptured. 

Click Recapture Camera Image from the Window menu. The still image will switch to video and 

the following message will be displayed. 

 

 

 

 

 

 

 

 

Clicking the OK button switches the camera image from video to still image to capture a new 

camera image. To return the original camera image, click the Cancel button. 

  

Click 
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Before recapturing After recapturing 

 

 

 

 

 

 

 

 

 

 

 
Recapturing is possible as many times as needed before the file is saved. 
Note that recapturing is not possible once the file is saved. 
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9－8. Measurement Data Analysis 

 

Measurement Data 
After completion of measurement, a square pointer    will be displayed on the camera image. 

Dragging this pointer to the desired point can display the spectrum data at the relevant point. 

The pointer automatically moves to the highest level point immediately after measurement is 

complete or the file is opened. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking on the graph moves the position of the red line, and shows frequency and level values of 

its position on the top of the graph. The red line automatically moves to the maximum peak value 

after five seconds. 

 

 

 

 

 

 

 

In the Condition tab, the conditions configured before measurement can be checked. The 

representation of measurement data can be changed in the Map View tab and Graph View tab. In 

the Comment tab, measurement information and other comments can be entered. 

 

 

Pointer 
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Condition tab Map View tab 

Comment tab Graph View tab 
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Auto Distribution 
When the Auto Distribution checkbox is checked, the color map is made according to automatic 

distribution between the highest and lowest intensity.  

 

 

 

 

To change the Upper/Lower Value to desired values, uncheck the Auto Distribution checkbox 

and click the Set button. The set upper/lower value settings will be reflected applied to the color 

bar. 

 

 

 

 

 

 

 

 

 

 
The upper and lower limit values can be fixed to any before or during measurement. Adjusting 
them with the upper and lower limit values at the previous measurement can make changes 
easy to perceive visually. 

 

Interpolation 
When the Interpolation checkbox is checked, the map data image is smoothly displayed by 

interpolation of the boundaries between divisions. 

 

 

 

 

  

Click 
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Transmittance: 0% Transmittance: 100% 

 

 

 

 

 

 

 

 

  

Transmittance 
The transparency of the color map can be changed. 

When Transmittance is set to 100%, the map is invisible and only the camera image will be 

displayed. When Transmittance is set to 0%, the camera image is invisible at the points where 

data exist. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Without interpolation With interpolation 
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No inversion Vertical inversion 

Vertical and horizontal inversion Horizontal inversion 

 

Image Inversion 
If the boxes are checked, the camera image and measurement data are inverted vertically and/or 

horizontally. The inversion status cannot be changed during measurement. When the 

measurement is stopped, the status can be changed again. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
When the movement of the electromagnetic field sensor on the camera image is inverted from 

the actual movement, inverting the camera image makes the measurement easier. 
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Display Data Comparison 
Two data can be displayed for comparison by reading the measurement data saved previously. 

Click Read to display the dialog box and read the data to be used for comparison. The data to be 

read must have the same image division size, start frequency, end frequency, and number of 

measurement points by the spectrum analyzer. 

 

 

 

 

After the data is read, its file name appears next to the Read button. Also, a new tab for Condition 

2 appears, and when the tab is selected, the measurement conditions of the read data can be 

confirmed. For Condition 2, Enable Factor cannot be changed. 

 

 

 

 

 

 

 

 

 

 

 
 
 

Data to be displayed can be selected from the following four types. Spectrum waveforms are 

displayed in yellow for the target measurement data and in blue for the data to be compared. 
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Color Bar Color Bar (Interpolation) 

 

When the difference is displayed, the color bar changes and divisions showing level increase are 

displayed in red, those showing level decrease in blue, and those showing no difference in white. 

As the difference increases in a division, its color becomes darker. The method for difference 

comparison can be selected from the following. 

 

 

 

 

 

 

When the Interpolation checkbox is checked, the map data image is smoothly displayed by 

interpolation of the boundaries between divisions. 

 

 

 

 

 

 

 

  

1.Target Data The target measurement data is displayed. 

2.Comparison Data The read data to be compared is displayed. 

Target - Comparison Data 

For each image division, the difference between the peak of the 

target measurement data and the peak of the comparison data 

is calculated and color-coded. 

Comparison - Target Data 

For each image division, the difference between the peak of the 

comparison data and the peak of the target measurement data 

is calculated and color-coded. 

dB The difference is calculated in decibel value. 

uV (when unit is dBuV) 
The difference is calculated after the unit is 

converted from dBuV to uV. 

mW (when unit is dBm) 

The difference is calculated after the unit is 

converted from dBm to uV. The unit is converted to 

mW after calculation. 
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1.Target Data 2.Comparison Data 

Target - Comparison Data Comparison - Target Data 

Target - Comparison Data (Interpolation) 
 

Comparison - Target Data (Interpolation) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The comparison can be easier when “New Measurement under the Same Condition” on page 
27 or “Display Ghost Image” on page 35 is referred to together. 
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Measurement Completion Mark 
If Measurement Completion Mark is checked on the Map View tab, clock marks are displayed in 

the image divisions where spectrogram measurement is completed. Refer to “Spectrogram 

Measurement (Setting Measurement Conditions)” on page 59 for the spectrogram measurement. 

 

 

 

 

 

 

 

 

 

 

  

Frequency Range 
If the Specified Frequency checkbox is checked under Frequency Range, the map is 

color-coded not using the peak values of the whole frequency range but using those of the 

specified frequency range, and the relevant blue zone band is displayed in the spectrum graph. 

This zone band can be moved to the right or left by dragging it, and thereby the color-map on the 

camera image changes. In addition, the width of the zone band can be changed by dragging an 

end of the band to the right or left. 

 

 

 

 

 

Clicking the Set button opens the Frequency Setting dialog box, where the frequency range for 

the zone band can be directly entered. 

 

 

 

 

 

Click 
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Enlarge Specified Range is checked 
 

Level range is changed (40 dBuV – 120 dBuV） 

Specified level is unchecked (7 dBuV – 107 dBuV) 

If Enlarge Specified Range is checked, the frequency range in the graph changes to the specified 

frequency range.   

 

 

 

 

 

 

 

 

 

 

Level Range 
If Specified Level is checked, the level range can be changed. Clicking the Set button opens the 

Level Setting dialog box to change the upper and lower limits for the level range. If Specified 

Level is unchecked, the level range during measurement is restored. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The level range can be changed before, during, and after measurement. 
The upper value is automatically adjusted so that the vertical scale values become integer. 

 

Click 
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Linear (Linear axis) 

Log (Logarithmic axis) 

 

Unit Switch 
The unit used to display measured intensity can be selected from dBuV and dBm. 

The change of unit will be applied to the color bar and spectrum graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Frequency Axis Switch 
Linear (Linear axis) or Log (Logarithmic axis) can be selected as the frequency axis in the spectrum 

graph. Log uses a logarithmic scale. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Displayed in dBuV Displayed in dBm 
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Map Comment dialog box 

 

Map Comment 
Clicking the Map Comment button opens the Map Comment dialog box. In the Map Comment 

dialog box, markers can be added to the image division at the current pointer position. Comments 

can be registered for each marker. The Map Comment dialog box can be displayed only after 

measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Marker Pointer 

Click 
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Clicking the Add button for each color adds a marker in that color. The function keys (F1 to F6) on 

the buttons can also be added using the keyboard. 

 

 

 

 

 

 

 

 

The Marker Add Division shows the current pointer position, and the marker is added to this 

division. If a marker is already registered for a division, it will be overwritten. 

 

 

 

The content entered in the edit box to the right of the Add button is registered as a comment when 

a marker is added. 

 

 

 

 

 

 

 

 

The added markers are listed on the list. Comments registered to markers can be checked here. 

Clicking on the list automatically moves the pointer to the position of the selected marker in the list. 
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Clicking the Edit Selected Marker button edits the color and comment of the marker selected on 

the list. Clicking the Delete Selected Marker button deletes the selected marker on the list. 

Clicking the Delete All Markers button deletes all markers. 

 

 

The marker display method can be selected from the following three types. 

 

 

 

 

 

 

 

Measurement Information 
The measurement date is automatically input in the Day field. For other items, enter information 

freely. If no information is required, leave the field blank. 

 

 

 

 

 

 

Memo 
Any information about measurement can be entered freely. In the Memo field, there is no limit of 

the number of characters. 

 

 

 

 

 

  

All markers All added markers are displayed. 

Selected marker Only marker selected on the list is displayed. 

Hidden Markers are not displayed. 
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After batching window settings 
 

Before batching window settings 
 

Batch Window Settings 
The same settings can be applied to part of the map view and the graph view on the Map Data 

View windows that are currently open. Click Batch Window Settings on the Window menu to 

display the Batch Window Settings dialog box. Click the OK button to reflect the map view and 

graph view settings on the last active View window on the measured map View window that is 

currently open. 

The reflected settings are as follows:  

Upper/Lower Value, Interpolation, Transmittance, Image Inversion, Display Data Comparison 

(when comparison data is read), Method for Comparison, Display of Measurement Completion 

Mark, Specified Frequency (the START and STOP frequencies are the same among Windows), 

Enlarge Specified Range (the START and STOP frequencies are the same among Windows), Unit 

Switch, Frequency Axis Switch, the Upper/Lower limits for the level range (the Specified Level is 

checked), and Display/Color Assignment (the Create Density Display is checked). 

Use this function to compare measurement data put side by side. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

Click 
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Black and White Inversion 

Normal 

 

Black and White Inversion 
The spectrum graph can be displayed inversely in black and white. 

Right click on the spectrum graph and click Black and White Inversion to invert the color of the 

graph. Use this function to print the graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Exporting Measurement Data 
Measurement data can be exported to an external file. 

Select Export from the File menu, and choose one from Map Data, Spectrum Data, and All 

Spectrum Data. The Save As dialog box will appear. 

 

 

 

 

 

 

 

 

 

 

In Save as type on the Save As dialog box, either CSV File or Bitmap File can be specified. 

Click 
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 Map Data 

CSV file: The peak values for each measurement point are exported. When difference is 

displayed in “Display Data Comparison” on page 44, the difference for each measurement 

point is output. 

BMP file: The map data image pasted on the camera image is exported. 

 Spectrum Data 

CSV file: The spectrum waveform data for the point indicated by the pointer    is exported. 

BMP file: The spectrum graph image for the point indicated by the pointer    is exported. 

 All Spectrum Data 

CSV file: The spectrum data for all measurement points are exported. This cannot be selected 

when the difference is displayed in “Display Data Comparison” on page 44. 

 

 
When the comparison data is read in “Display Data Comparison” on page 44, the displayed 
data is exported. 
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Coordinate Output Settings 
By specifying a point on the Map View, the image division and coordinates of the specified point 

can be output as explained in “Exporting Measurement Data” on page 54. Use this function for data 

linkage with software supplied by another company. 

When Coordinate Output Settings is selected in the File menu, the Coordinate Output Settings 

dialog box appears, and checking Output Settings Enabled enables the function. Coordinates 

can be specified at four points: P1 (top left), P2 (top right), P3 (bottom right), and P4 (bottom left). 

Select each radio button and click or drag on the Map View to register the positions. Click Clear All 

Points to clear the registered information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the function is enabled, the mouse cursor can be selected from cross and normal. Select a 

cursor that can easily specify the positions. 

  

Click 
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Print Preview 

Print 
The measurement conditions, map image, and spectrum graph can be printed. 

Select Print or Print Preview from the File menu or select the Print button on the toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

Click 

Click 
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Old Antenna Factor: 901_6cm_Loop_v2 New Antenna Factor: THROUGH 

 

Antenna Factor Reloading 
The Antenna Factor of the measured data can be reloaded. Refer to “Antenna Factor” on page 32 

for the Antenna Factor. 

Click Antenna Factor Reloading... from the File menu. The Antenna Factor Reloading dialog 

box will appear and allow the desired Antenna Factor to be specified. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To save the reloaded Antenna Factor, click Save As... from the File menu and save the file under a 

different name. 

 

 

 

 

  

Click 
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Measured Map Data Window 

Spectrogram Measurement View Window 

 

9－9. Spectrogram Measurement (Setting Measurement Conditions) 

Here, spectrogram measurement is available. It is a temporally continuous measurement for each 

image division of measured data that displays the result in three dimensions: time, frequency, and 

strength. The following section describes how to operate spectrogram measurement. 

 

New Measurement 
Spectrogram measurement specifies image divisions of measured map data and performs 

measurement for the divisions. 

Right click the desired division of the measured map data where spectrogram measurement should 

be performed to display the menu. Click Spectrogram Measurement in the menu to display the 

View window for spectrogram measurement. The values displayed to the right of Spectrogram 

Measurement indicate the selected division. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right Click Click 
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The name of the View window is the “Saved file name of map data_Cell (clicked division)”. When 

map data is saved with a name after the measurement by clicking Save As... from the File menu, 

the associated spectrogram measurement data is also saved as the “Saved file name of map 

data_Cell (clicked division)”. 

 

 
Before spectrogram measurement, the measured map data needs to be saved. The 
spectrogram measurement data is automatically saved in the same folder as the map data. 
Also, to perform spectrogram measurement, the image inversion of map data needs to be 
canceled. 

 

Condition Tab 
In the Condition tab, set the measurement ending conditions, properties for the spectrum analyzer, 

and other conditions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The settings of frequency, spectrum analyzer and Antenna Factor take over the settings for the 

specified division of map data. 

 

 
The settings of Frequency, Spectrum Analyzer and Antenna Factor can be changed only 
when the functional limitation is canceled. Refer to “Functional Limitation” on page 24 for the 
functional limitation. 

 

 
Refer to “Density Display” on page 29 for the Density Display. 
Refer to “Frequency” on page 31 for the Frequency. 
Refer to “Spectrum Analyzer” on page 31 for the Spectrum Analyzer. 
Refer to “Antenna Factor” on page 32 for the Antenna Factor. 
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Measurement Ending Conditions 
Conditions for automatically ending measurement are specified here. If Move Out of Measured 

Division is checked and the electromagnetic field measurement sensor moves out of the clicked 

division, the measurement automatically ends. If Specified Time Elapsed is checked, the 

measurement automatically ends when a specified time has elapsed. 

 

 

 

 

Specified Sweep Start Interval 
An interval for sending the sweep start command to the spectrum analyzer is specified here. If 

Shortest is selected, the command is sent at the shortest possible interval. If Specify Interval is 

selected, the command is sent at the specified interval. 

 

 

 

 

 
If the sweep start command is not successfully sent at the specified interval, the message, 
“There is data exceeding the specified sweep start interval.” is displayed at the top of the 3D 
graph screen.  
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9－10. Spectrogram Measurement (Performing Measurement) 

 

Performing Measurement 
When the View window of spectrogram measurement is displayed, the map data screen switches 

to video display. Align the position of the electromagnetic field measurement sensor with the 

selected image division which is blinking in black and white on the video, and fix the sensor. When 

the sensor position is aligned, the blinking light turns white. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Display Ghost Image is available before and during the spectrogram measurement. Refer to 
“Display Ghost Image” on page 35 for the Display Ghost Image. 

 

To start measurement, click the START button in the upper right of the View window. During 

measurement, the PAUSE and STOP buttons are enabled. 

To suspend measurement, click the PAUSE button to suspend measurement, and to finish 

measurement, the STOP button. When measurement ending conditions are set, the measurement 

automatically ends according to the conditions.  

After completion of measurement, all buttons are disabled. To perform measurement again, right 

click on the map data and select Spectrogram Measurement. 

 

 

 

 

 

While measurement is in progress, the settings in the Condition tab cannot be changed. All items 

in the Spectrogram View tab can be changed. In the Graph View tab, only Unit Switch and 

Frequency Axis Switch are active.  

During the measurement, waveform data is displayed in a 3D graph of frequency, level and time. In 

During measurement 
 

After measurement 
 

STOP PAUSE 

Before measurement 
 

START 

Align the sensor position 



9.Operation Procedure 

 63

addition, the latest waveform data measured by the spectrum analyzer is displayed in the spectrum 

graph at the bottom of the View window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Note that if the noise level emitted from the EUT is high, the spectrum analyzer and 
preamplifier may be damaged by excessive input. 

 

Messages 
During or after measurement, messages may be displayed at the top of the 3D graph. The 

messages and their descriptions are as follows. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 “Reading data from the file” 

Displayed when reading measurement data saved in the file. 

 “Saving data to the file.” 

Displayed when saving measurement data in the memory to the file. 
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 “Failed to generate a peak. The maximum number of peaks displayed is changed. If the failure 

persists, closing other windows may improve the situation.” 

Displayed when generation of the peaks that make up the 3D graph fails. When multiple view 

windows of spectrogram measurement are displayed, closing all of them and reopening the 

View window may improve the situation. 

 “Failed to create index buffer. The number of displayed data is limited.” 

Displayed when creation of index buffer for displaying a 3D graph fails. The number of 

displayed data to create index buffer is limited. 

 “Some data are not displayed because the maximum number of displayed peaks is exceeded.” 

In EPS-02Ev3, since the upper limit of the number of peaks that make up the spectrogram is 

set, when the set value is exceeded, only a part of the spectrogram is displayed, resulting in 

the appearance of this message. The upper limit of the number of peaks changes depending 

on the hardware performance as well. 

 “The addition of sweep data is temporarily stopped because the sweeping speed exceeds the 

data saving speed.” 

Displayed when the speed for acquiring data exceeds the speed for saving data in the file, and 

the data acquisition is temporarily stopped. 

 “There is data exceeding the specified sweep start interval.” 

Displayed when there is data that cannot be acquired at the specified interval when 

measurement is performed with the sweep start interval set to the specified interval. 

 “As the display time range exceeds the data range in the memory, some data may not be 

displayed.” 

Displayed when the display time range of the 3D graph exceeds the data range in the memory, 

and some data may not be displayed. To display the data, the display time range needs to be 

shortened. For the change of the display time range, refer to “Axis Display Settings” on page 

69.  
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Rotation Movement 

 

9－11. Spectrogram Measurement (Measurement Data Analysis) 

 

Measurement Data 
After the measurement, a clock mark is displayed in the division of measured map data. Right click 

a division with the clock mark to display the menu. The menu items are described as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The shape of the mouse pointer turns    on the 3D graph screen, and dragging it rotates the 

graph. Clicking the wheel button turns the shape of the mouse pointer    , and dragging it 

moves the 3D graph. Moving the wheel button up and down zooms in and out the 3D graph. 

 

 

 

 

 

 

 

 

 

  

Spectrogram 

Measurement 

Displays a new measurement View window and 

performs measurement again. Note that the 

original data is deleted when the new 

measurement is performed. 

Display Measured Data Displays the measured data View window. 

Delete Measured Data 
Deletes measured spectrogram data. Note that the 

data cannot be restored once deleted. 

Right Click 
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Zoom in Zoom out 

 

 

 

 

 

 

 

 

 

Dragging the slider displayed below the 3D graph or selecting the triangle on the right or left 

specifies a spectrum waveform to be displayed. The scale on the slider bar is color-coded by the 

peak values of the corresponding waveforms. The sweep start time of the specified waveform 

based on the reference time is displayed at the top of the slider. Also, the selected waveform 

position in the 3D graph is displayed as a red rectangle. Refer to “Slider” on page 73 for the 

reference time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Click the triangle on the left or right of the slider bar to move to the next waveform. Press and 
hold it to move continuously. 

Drag 

Selected Waveform Position 
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In the Condition tab, the conditions configured before measurement can be checked. The 

representation of measurement data can be changed in the Spectrogram View tab and Graph 

View tab. In the Comment tab, measurement information and other comments can be entered. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Refer to “Measurement Information” on page 52 and “Memo” on page 52 for the Comment 
tab. 

Spectrogram View tab Comment tab 

Condition tab 

Graph View tab 
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Auto Distribution 
Check Auto Distribution to color-code the 3D graph according to the maximum and minimum 

values of data within the display time range of the graph. 

 

 

 

To change the Upper/Lower Value to desired values, uncheck the Auto Distribution checkbox and 

click the Set button. The set upper/lower value settings will be reflected applied to the color bar. 

 

 

 

 

 

 

 

 

 

 
The upper and lower limit values can be fixed to any before or during measurement. Adjusting 
them with the upper and lower limit values at the previous measurement can make changes 
easy to perceive visually. 

 

Initialization 
Click the Initialization button to reset the rotation, movement and scaling of the 3D graph to its 

initial state. 

 

 

 

 

 

 

 

 

 

 

 

Click 

Click 
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Axis Display Settings 
Click the Set button to display the 3D Graph Axis Display Settings dialog box and change the 

display of the frequency axis, level axis, and time axis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the frequency axis setting, the display of axis labels, Start/Stop values, and scale lines can be 

switched and the size of the frequency axis can be changed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Change of Display by Frequency Axis 
Setting 

3D Graph Axis Display Settings dialog 

Click 
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In the level axis setting, the display of axis labels, scale values, and scale lines can be switched 

and the size of the level axis can be changed. 

 

 

 

 

 

 

 

 

 

 
If the size of the level axis is set to zero, the level is displayed only by color. 

 

 

 

 

 

 

 

 

 

 

 

 

In the time axis setting, the display of axis labels, scale values, and scale lines can be switched and 

the size of the time axis can be changed. If the display time range is changed, the time axis range 

can be changed in seconds. 

 

 

 

 

 

 

 

 

 

Change of Display by Level Axis 
Setting 

Change of Display by Time Axis 
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If a long display time range is set, part of the spectrogram may not be displayed beyond the 
maximum number of peaks that can be displayed on EPS-02Ev3. In this case, the message 
"Some data are not displayed because the maximum number of displayed peaks is exceeded" 
is displayed at the top of the 3D graph screen. 

 

Click the Initialization button to reset all items to their initial states. Click the Apply button to apply 

the settings to the 3D graph while displaying the dialog box. Click the OK button to apply the 

settings and close the dialog box. Click the Cancel button to close the dialog box without applying 

the settings. 

 

 

Display Format 
The display format of the spectrogram can be changed. Select Line to display spectrum waveforms 

in line along the time axis. Select Interpolation to interpolate and display adjacent spectrum 

waveforms on the time axis. 

 

 

 

 

 

 

 

 

 

 

 

Display Time Range: 30 seconds  Display Time Range: 1 second 
 

Line Display Interpolation Display 
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Selected Position 
Uncheck Position Display not to display the selected waveform position on the 3D graph. 

 

 

 

 

 

 

 

 

 

 

 

Uncheck Future Side Display not to display waveforms on the future side of the selected 

waveform position on the 3D graph. Uncheck Past Side Display not to display waveforms on the 

past side of the selected waveform position on the 3D graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Position Display is checked Position display is unchecked 

Future Side Display is unchecked Past Side Display is unchecked 
 

Both are unchecked 
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Slider 
Uncheck Slider Display not to display the slider. 

 

 

 

 

 

 

 

 

 

 

 

 

 

As a reference time, either End Time or Start Time can be selected. Select End Time to set the 

sweep start time of the waveform at the end of measurement as the reference time 0. Select Start 

Time to set the sweep start time of the waveform at the start of measurement as the reference time 

0. 

 

 

 

 

 

 

 

 

 

 

 

 
Immediately after the measurement and after opening the measured spectrogram data, the 
waveform of the reference time is selected. 

 

Slider Display is checked Slider Display is unchecked 

End Time is selected 

Start Time is selected 

End time 

Start time 
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Select Waveform 
A method for selecting a spectrum waveform is specified here. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Comparison Target 
The comparison data can be overlaid on the spectrum graph at the bottom of the View window. 

Click the Set button to display the Setting dialog box, select a comparison target, and click the 

Apply or OK button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

End Waveform The waveform at the end of measurement is selected. 

Start Waveform The waveform at the start of measurement is selected. 

Select from Slider 
Selected from the slider. If the slider is clicked, the setting 

automatically switches to this. 

Specify from Time 
Specify the number of seconds and click the Display button to 

select the waveform closest to the specified time. 

Max Peak within Display 

Time 

The waveform with the maximum peak is selected within the 

display time range of the 3D graph. 

Max Peak within Total 

Time 

The waveform with the maximum peak is selected within the 

total measurement time. 

Name displayed at the top of the spectrum 

Click 
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In Display Setting, Display Selected Waveform and/or Display Comparison Data can be 

selected. Unchecking the boxes and clicking Apply or OK cancels display. Use this function to 

display only one of the data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

None No comparison target is displayed. 

Current Selected 

Waveform 

The waveform currently displayed on the spectrum graph is displayed as 

the comparison target. Change selected graphs to select any waveform 

for comparison. 

Max Peak 

Waveform 

The waveform with the maximum peak in the total measurement data is 

displayed. 

Average 
Averages for all frequency points are calculated for the total 

measurement data and displayed by connecting them with a straight line. 

Average + Standard 

Deviation 

Averages and standard deviations for all frequency points are calculated 

for the total measurement data and displayed. The average is displayed 

as a blue line, and the standard deviation as a purple T at each 

frequency point. 

Max Hold 
Maximum values for all frequency points are calculated for the total 

measurement data and displayed by connecting them with a straight line. 

Min Hold 
Minimum values for all frequency points are calculated for the total 

measurement data and displayed by connecting them with a straight line. 

Both are checked 

Display Selected Waveform is unchecked 
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Click Apply to create the comparison data and apply it to the spectrum graph without closing the 

dialog box. Click OK to create the comparison data only when no data is created, and apply it to the 

spectrum graph after closing the dialog box. While the comparison data is being created, the 

progress bar shows the progress. Click Cancel Creation to cancel the process. 

 

 

 

 

Click on the spectrum graph to move the position of the red line, and the comparison data value at 

the position is displayed on the upper left of the graph. 

 

 

 

 

 

 

Frequency Range 
If the Specified Frequency checkbox is checked under Frequency Range, the display frequency 

range in the spectrogram changes to the specified frequency range, and the relevant blue zone 

band is displayed in the spectrum graph. 

This zone band can be moved to the right or left by dragging it, and thereby the display frequency 

range in the spectrogram changes. In addition, the width of the zone band can be changed by 

dragging an end of the band to the right or left. 

 

 

 

 

 

Clicking the Set button opens the Frequency Setting dialog box, where the frequency range for 

the zone band can be directly entered. 

 

 

 

 

 

Click 
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Enlarge Specified Range is checked 

Level range is changed (40 dBuV – 120 dBuV） 

Specified level is unchecked (7 dBuV – 107 dBuV) 

If Enlarge Specified Range is checked, the frequency range in the spectrum graph changes to the 

specified frequency range. 

 

 

 

 

 

 

 

 

 

 

 

Level Range 
If Specified Level is checked, the level range can be changed. Clicking the Set button opens the 

Level Setting dialog box to change the upper and lower limits for the level range. If Specified 

Level is unchecked, the level range during measurement is restored. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The level range can be changed before, during, and after measurement. 

Click 
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Linear (Linear axis) 
 

Log (Logarithmic axis) 
 

 

Unit Switch 
The unit used to display measured intensity can be selected from dBuV and dBm. 

The change of unit will be applied to the color bar, 3D graph, and spectrum graph. 

 

 

Frequency Axis Switch 
Linear (Linear axis) or Log (Logarithmic axis) can be selected as the frequency axis in the 3D graph 

and spectrum graph. Log uses a logarithmic scale. 
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Spectrogram Comment dialog box 
 

 

Spectrogram Comment 
Clicking the Spectrogram Comment button opens the Spectrogram Comment dialog box. In the 

Spectrogram Comment dialog box, markers can be added at the bottom of the slider. Comments 

can be registered for each marker. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

Marker 
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Clicking the Add button for each color adds a marker at the bottom of the slider in that color. The 

function keys (F1 to F5) on the buttons can also be added using the keyboard. 

 

 

 

 

 

 

During measurement, the current time is displayed at the Marker Add Time. After measurement, 

the time selected with the slider is displayed. The marker is added at this time. If a marker is 

already registered, it will be overwritten. 

 

 

 

The content entered in the edit box to the right of the Add button is registered as a comment when 

a marker is added. 

 

 

 

 

 

 

The added markers are listed on the list. Comments registered to markers can be checked here. 

Clicking on the list after measurement automatically moves the slider to the time vicinity of the 

marker selected on the list. 

 

 

 

 

 

 

 
The maximum number of markers that can be added is 1000. 
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Clicking the Edit Selected Marker button edits the color and comment of the marker selected on 

the list. Clicking the Delete Selected Marker button deletes the selected marker on the list. 

Clicking the Delete All Markers button deletes all markers. 

 

 

The marker display method can be selected from the following three types. 

 

 

 

 

 

 

 

 

Batch Window Settings 
The same settings can be applied to part of the spectrogram view and the graph view on the 

Spectrogram Data View windows that are currently open. Click Batch Window Settings on the 

Window menu to display the Batch Window Settings dialog box. Click the OK button to reflect 

the map view and graph view settings on the last active View window on the measured 

spectrogram View window that is currently open. 

The reflected settings are as follows:  

Upper/Lower Value, the rotation, movement and scaling of the 3D graph, Axis Display Settings, 

Display Format, Position Display, Future Side Display, Past Side Display, Slider Display, the 

reference time, Specified Frequency (the START and STOP frequencies are the same among 

Windows), Enlarge Specified Range (the START and STOP frequencies are the same among 

Windows), Unit Switch, Frequency Axis Switch, the Upper/Lower limits for the level range (the 

Specified Level is checked), and Display/Color Assignment (the Create Density Display is 

checked). 

Use this function to compare measurement data put side by side.  

All markers All added markers are displayed. 

Selected marker Only marker selected on the list is displayed. 

Hidden Markers are not displayed. 
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Before batching window 
settings 

After batching window settings 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Click 

Click 



9.Operation Procedure 

 83

 

Black and White Inversion 
The 3D graph and spectrum graph can be displayed inversely in black and white. 

Right click on the 3D graph or spectrum graph and click Black and White Inversion to invert the 

color of the graph. Use this function to print the graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exporting Measurement Data 
Measurement data can be exported to an external file. 

Select Export from the File menu, and choose one from Spectrogram Data(Display Time 

Range), Spectrum Data, and All Spectrum Data. The Save As dialog box will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

Click 
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In Save as type on the Save As dialog box, either CSV File or Bitmap File can be specified. 

 

 

 

 

 

 

 

 

 

 

 

 

 Spectrogram Data(Display Time Range) 

CSV file: Waveform data for the time range displayed on the screen is output. The progress 

bar in the Progress Display dialog box indicates the progress of the export process, and 

clicking Cancel cancels the export. 

BMP file: The 3D graph image is exported. 

 Spectrum Data 

CSV file: The data of the selected waveform is output. When comparison data is selected, the 

comparison data is also output. 

BMP file: The spectrum graph image is exported. 

 All Spectrum Data 

CSV file: The spectrum waveform data for the total measurement time is output. The progress 

bar in the Progress Display dialog box indicates the progress of the export process, and 

clicking Cancel cancels the export. 

 

 

 

 

   

 

 
When data volume to be exported is large, exporting may take a long time. Data volume to be 
exported can be adjusted by using export within the display time range. 
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Print Preview 
 

 

Print 
The measurement conditions, spectrogram image, and spectrum graph can be printed. 

Select Print or Print Preview from the File menu or select the Print button on the toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Click 

Click 
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Antenna Factor Reloading 
The Antenna Factor of the measured data can be reloaded. Refer to “Antenna Factor” on page 32 

for the Antenna Factor. 

Click Antenna Factor Reloading... from the File menu. The Antenna Factor Reloading dialog 

box will appear and allow the desired Antenna Factor to be specified. 

 

 

 

 

 

 

 

 

 

 

 

 

 

When data volume is large, reloading the Antenna Factor may take a long time. The progress bar in 

the Progress Display dialog box indicates the progress of the reloading process, and clicking 

Cancel cancels reloading the Antenna Factor. 

 

 

 

 

 

 

 
Reloading the Antenna Factor of the spectrogram measurement data rewrites the data saved in 
the file. 

 

 

 

 

 

Click 
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Data Management dialog box 
 

 

9－12. Data Management 

Click Data Management... from the File menu to display the Data Management dialog box. In the 

Data Management dialog box, measurement data in a folder can be displayed with thumbnail 

images. A Folder is selected in the folder tree on the left side of the dialog box. 

 

 

 

 

 

 

 

 

 

 

Display Items 
The items displayed in Data Management are as follows. 

(1) File name 

The file name of the displayed data. 

(2) Open 

Select to open the file. 

(3) Map / Spectrogram 

Thumbnail image of the map or 

spectrogram. The image at the time 

of data saving is displayed. 

(4) Spectrum graph 

Thumbnail image of the spectrum 

graph. The image at the time of data 

saving is displayed. 

(5) Model 

The content entered in the Model of 

the Measurement Information. 

(6) Serial No. 

The content entered in the Serial No. 

of the Measurement Information. 

Click 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 
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4 columns 
 

(7) Day 

The content entered in the Day of the Measurement Information. 

(8) Memo 

The content entered in the Memo. 

 

 
Thumbnail images may not be displayed for measurement data saved with older software 
versions. In this case, overwrite the data and the thumbnail image will be displayed. 

 

Data Management Settings 
Click the Data Management Settings button to change settings related to data management. 

 

 

 

 

 

 

 

 

(1) Number of columns 

Specify the number of columns to list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

(1) 

(2) 

(3) 
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(2) Sort by 

Specify the sorting criteria. The criteria can be selected from File name, Day, Model, and 

Serial No. The sort order can be selected from ascending or descending. Sorting is performed 

by comparing strings. 

 

 

 

 

 

(3) Display item 

Specify items to be displayed. Only checked items will be displayed. The File name and the 

Open button are always displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 
The number of data that can be displayed at one time is limited to 48, regardless of the data 
management settings. Clicking the Next button at the top of the Data Management dialog box 
displays data after the currently displayed data. Clicking the Previous button displays the data 
before the currently displayed data. 
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10. Setup 
 

10－1.  Important Notes on Setup 

 
This section describes setup for the software and peripheral devices. To perform setup, you must be 
logged in with administrator privileges. 
Also, it is recommended that setup be performed by some engineer with a certain degree of 
proficiency in computers, including having an understanding of Ethernet addresses and other 
terminology. 
Be aware that some details may vary for different OS versions, PC display settings, and other 
environments. 

 

10－2.  Network Address Settings 

 

1) Setting the IP Address of the PC 

From the Control Panel, select Network and Sharing Center, and click Change adapter 

settings from the list on the left side. 

 
<How to open Control Panel> 
[Windows 10] 

In the search box on the taskbar, type Control Panel, and then select Control Panel. 

[Windows 7] 

Click the Start button, and then click Control Panel. 

 

The adapters that can connect to the network are displayed. Double-click the adapter (local area 

connection) that is connected to the spectrum analyzer to display its properties. Select "Internet 

Protocol Version 4", and click to display the properties. 

 

 

Enter "192.168.99.3" for the IP address  

and "255.255.255.0" for the subnet mask,  

and click OK. 

This completes the IP address settings  

for the PC. 
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2) Set the IP address of the spectrum analyzer 

For details on the spectrum analyzer settings, see the instruction manual for the spectrum 

analyzer. 

Set the IP address to "192.168.99.100" and the subnet mask to "255.255.255.0". 

 

10－3.  Installing the Software 

 

1) Installing NI-VISA 

Load the supplied setup media, and open the "NI-VISA" folder. Run Install.exe to start the 

installation process. Then, perform installation by following the instructions from the installer. 

When installing, make sure that the installation items include NI-VISA. 

 

2) Installing the EPS-02Ev3 Software 

Load the supplied setup media, and open the "EPS-02Ev3" folder. 

Run EPS-02Ev3_En.msi to start the installation process. Then, perform installation by following 

the instructions from the installer. 

 

3) Use of the supplied USB protect key 

The supplied protect key is not required for checking the measurement data. For carrying out a 

measurement by controlling the peripherals, the supplied protect key is required. 

 

It is required to install the driver of the USB protect key before use. The driver file is in “JSP USB” 

folder in the supplied setup media. After you insert the USB protect key into a USB port of the PC 

where EPS-02Ev3 software in installed, open Device Manager and select “unknown devices” or 

“HardKey” of “other devices” and install the driver. 

 

The program can run a measurement only when the USB protect key is inserted into the PC. The 

USB protect key can be plugged into any USB port. 

 

4) Use of the RSA306B 

Load the supplied setup media, and open the RSAAPI folder. Open the 32bit or 64bit folder 

according to the PC. Run setup.exe to start the installation process. Then, perform installation by 

following the instructions from the installer. 

* This operation is required only when RSA306B is used as a spectrum analyzer. 
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11. Antenna Factor Editor 
 

11－1. Overview 

Antenna Factor Editor is a Windows application by which an Antenna Factor file can be created and 
edited in the EPS-02Ev3 Electromagnetic Field Visualization System. 
 

11－2. Starting and Exiting the Software 

 

Starting the Software 
Double-click FactorEditor.exe stored in the folder where the EPS-02Ev3 executable file is stored 

(C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev3, under normal conditions). 

 

Exiting the Software 
Click the close button on the right end of the title bar or click Exit from the File menu. 

11－3. Description of the Screen 

 

Entire Screen 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set 
frequencies 

 

Level 
correction 

values 

[Frequency unit] 
selection button 

[Data creation] 
button 

Data edit box 
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File Menu 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① New Measurement 
Creates a new correction data file. 
 

② Open... 
Opens an existing correction data file (*.ant). 
 

③ Save 
Saves the correction data file being edited. 
 

④ Export 
Exports the correction data being edited to a CSV file. 
 

⑤ Import 
Imports correction data from a CSV file. 
 

⑥ Exit 
Exits the application. 

 

Pop-up Menu (Right-Click) 
 

 

 

 

 

 

 

 

① Add row 
Adds a row to the end of the correction data list. 
 

② Insert row 
Adds a row to the front of the selected correction data list. 
 

③ Delete row 
Deletes a row of the selected correction data list. 
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11－4. Operation Procedure 

 

New Measurement 
On the menu bar, select File → New Measurement. By double-clicking on the empty list, one 

record can be added. Then, set Frequency and Factor to the desired values. Up to 99 records can 

be added. 

When the necessary data input is complete, click the Data creation button to create a data file. 

The file is only available by putting it in the folder where the EPS-02Ev3 executable file is stored 

(C:¥Program Files (x86)¥NoiseKen¥EPS-02Ev3, under normal conditions). 

 

Open... 
On the menu bar, select File → Open..., and select a file with the extension .ant in the Open dialog 

box to display the data list. 

By double-clicking a data item, the data can be edited. By clicking the Data creation button after 

editing, a data file with the edited data can be created. 

 

Import 
This tool can import a CSV file that was edited by another editor. 

On the menu bar, select File → Import, and select a file with the extension .csv in the Open dialog 

box to display the data list. By double-clicking a data item, the data can be edited. By clicking the 

Data creation button after editing, a data file with the edited data can be created. 

The first row of the file to be imported must be a header row including the frequency unit character 

string. 

 

 

 

 

 

 

 

 

Export 
This tool can export Antenna Factor correction data to a CSV file. 

On the menu bar, select File → Export, and specify a file name in the Save as dialog box to export 

the data in a CSV file. In addition, the tool can import and edit the Antenna Factor correction data 

that was once exported. 

The first row of the file to be exported is a header row including the frequency unit character string. 

(Note: Refer to “Import.”) 

 

 

 

 

For the frequency unit 
character string, specify one of 
the following: 
Hz, kHz, MHz 
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11－5. Editing Correction Data 

 

Set frequencies 
① Checking Consistency Between Records 

Since the frequencies set for the records are checked when creating a data file, be sure to set 
the frequency of the following record to a larger one than that of the previous record. 

 

 

 

 

 

 

 

 

② Treatment of fractions 
If the number of significant digits of a set frequency is seven or more, the first seven digits can be 
rounded to six digits. 
 

③ Checking the maximum and minimum settings 
The maximum and minimum set frequencies are checked. 
The minimum and maximum set frequencies are 1 Hz and 32 GHz, respectively. 
 

Level correction values 
① Positive/negative numbers 

Specify plus or minus relative values to the reference level (usually 0 dB) for level correction 
values. Plus and minus values are displayed in blue and red, respectively. 

 

 

 

 

 

 

 

 

② Treatment of fractions 
Level correction values can be rounded to two decimal places. 
 

③ Checking the maximum and minimum settings 
The maximum and minimum level correction values are checked. 
The minimum and maximum level correction values are -320 dB and 32 dB, respectively. 

Set the frequency of the following 
record to a larger one than that of 
the previous record. 
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11－6. Sample Antenna Factor 

The following is a sample Antenna Factor corresponding to characteristic curve data. 

Frequency characteristic curve 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Antenna Factor corresponding to the above 
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12. Specifications 
 

12－1. System Requirements 

 
OS : Microsoft Windows 10 (Japanese / English version) 

Microsoft Windows 11 (Japanese / English version) 
CPU : Intel Core i5 or better (i7 or better recommended) 

Memory : 8 GB or more recommended 

Storage : 10 GB or more free space 

Display : 1366 × 768 dots or more 
1920 × 1080 dots recommended 

 
Other requirements: 
 Operation cannot be guaranteed when using online storage or software that uses 

cloud services. 
 2 or 3 empty USB ports 

 
* The upgrade version and the minor upgrade version require a DVD drive for installation. 
* If software with high CPU utilization is running, the operation may become unstable. 
* The spectrum analyzer RSA306B may not work in combination with HP ProBook series. Please 
check in advance. 
* Refer to the manufacturer's website for the latest operation warranty of each device such as camera 
and spectrum analyzer. 
 
 

12－2. Supported Spectrum Analyzers 

 
Rohde & Schwarz FSV 

FSV3000 
FPL1000 
ESR 
ESRP 

Keysight Technologies N9010A 
N9010B 

Tektronix MDO4000series 
RSA306B 
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H

NETWORK ANALIZER

Pre Amp

Terminator
Micro strip line

  

12－3. Antenna Frequency Characteristics 

 

Model Probe Type Primary Sensor Structure Recommended 
Frequency Band 

901 6 cm Loop 

H-Field 

Shielded Loop 3 MHz ～ 500 MHz 

902 3 cm Loop Shielded Loop 5 MHz ～ 1 GHz 

903 1 cm Loop Shielded Loop 10 MHz ～ 3 GHz 

904 3.6 cm Ball 
E-Field 

Spherical Dipole 10 MHz ～ 3 GHz 

905 6 mm Stub Tip Short Monopole 50 MHz ～ 3 GHz 

     * Near field probe set of ETS-LINDGREN 
*The below frequency responses are measured by micro-strip line of Noise laboratory Co., LTD. 

  
 
 
 
 
 
 
 
 
 
 
 
 

■100 kHz ～ 100 MHz 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

901（6 cm Loop） 902（3 cm Loop） 

904（3.6 cm Ball） 903（1 cm Loop） 
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■100 kHz ～ 3 GHz 

 
 
 
 

905（6 mm Stub Tip） 

901（6 cm Loop） 902（3 cm Loop） 

903（1 cm Loop） 904（3.6 cm Ball） 

905（6 mm Stub Tip） 
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13. Warranty 
 

Repair Service Warranty 

 
This repair service warranty applies to the repair services provided for maintaining the designated 
functions and performance of NoiseKen products. 

 
1. Warranty Coverage 

This warranty covers NoiseKen products and their accessories. 
 
2. Technology and Work Fees 

If a breakdown occurs in a NoiseKen product, NoiseKen will provide repair services free 
of charge based on the warranty terms and conditions as long as the warranty period is 
still valid. If the warrant period has expired, the customer will bear the actual costs 
associated with technology and work for the repair. 

 
3. Ownership of Replacement Parts 

The ownership of all defective parts replaced in the course of performing the repair 
belong to NoiseKen. If the repair service fees are borne by the customer, NoiseKen will 
receive the replaced defective parts unless the customer specifically requests otherwise. 

 
4. Limitation of Liability 

If the customer incurs any damages due to the repair service or breakdown of the 
NoiseKen product purchased by the customer, the liability of compensation for damages 
by NoiseKen to the customer is limited to the amount paid by the customer for the 
applicable NoiseKen product or the applicable non-NoiseKen product (product by other 
manufacturer) only if these damages are due to the willful intent or negligence by 
NoiseKen. However, for damages incurred by the customer due to the above-described 
repair service provided by NoiseKen or breakdown of the applicable NoiseKen product, 
under no circumstances will NoiseKen be liable for any loss of potential income occurring 
directly or indirectly or any direct or indirect damages due to compensation by the 
customer to a third party. 

 
5. Wrong Parts, Missing Parts, or Breakage 

If the product cannot be used when a wrong part, missing part, or breakage occurs in a 
NoiseKen product purchased by the customer, NoiseKen will not be liable for any 
damages whatsoever for losses incurred by the customer due to loss of sales or other 
derived losses, special losses, or indirect or punitive damages, or any damages due to 
compensation by the customer to a third party. 

 
6. Decline to Repair 

The company may not accept a repeair order in the following cases. 

・ More than 5 years have passed since manufacture of a product discontinued. 

・ More than 8 years have passed after delivery. 

・ Required component for servicing already discontinued and no alternative is 
avaaiable. 

・ Product changed, repaired or remodeled without obtaining a prior permission from 
the Company. 

・ Product severely damaged to the extent it has lost its original form. 
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Product Warranty 

 
For breakdowns that occur within the product warranty period, NoiseKen will repair or replace the 
product free of charge. The extent and content of the repair work for the equipment will be 
determined by NoiseKen. This product warranty is valid in Japan only. 
 

1. Device Coverage 
This warranty covers NoiseKen products and their accessories. 

 
2. Product Warranty Period 

・ This warranty is for one year starting from the delivery date of the product. 
If the same breakdown at the same location is repaired, the warranty period is six 
months from the date that the repair was completed. 

・ For non-NoiseKen products, the product warranty of the supplier (manufacturer) applies. 

 
3. Exceptions 

Regardless of the above stipulations, the warranty does not cover breakdowns due to one of 
the following. 

 
 Replacement of consumable parts, including the replacement (for used products) of 

mercury relays, high-voltage relays, coaxial cords, coaxial connectors, automatic 
switchers, contactors, and other consumables 

 Damage or breakdowns that occurred due to failure to follow proper operating 
procedures. 

 Product failures resulting from damage or breakdowns due to modifications not 
involving NoiseKen 

 Product failures resulting from damage or breakdowns that occurred when someone 
unauthorized by NoiseKen attempted to perform repairs 

 Product failures resulting from damage or breakdowns caused directly or indirectly by 
natural disasters, war, riots, civil strife, or other force majeure 

 Product failures resulting from damage or breakdowns caused by transportation, 
vibrations, dropping, impact, or other misuse after delivery 

 Product failures resulting from damage or breakdowns caused by the usage 
environment 

 When the customer takes the product outside Japan 
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Software Warranty 
   
A warranty is provided for the software produced by NoiseKen and its update files under the 
following terms and conditions. This warranty is valid in Japan only. 

 
 

1. Scope of Warranty 
This warranty applies to the software produced by NoiseKen and its update files. 

 
2. Free Support 

If a fault occurs in the system as a result of this software by NoiseKen, NoiseKen will 
provide support free of charge through software fixes and updates or other means only 
within the warranty period. However, please be aware that we may discuss when to 
implement corrective measures for minor issues. 

 
3. Total Maximum Liability 

If the customer incurs losses or damages due to a fault of this NoiseKen software 
purchased by the customer, unless the losses or damages are the result of willful or 
negligent actions, the maximum amount of NoiseKen’s liability for compensation for 
these losses or damages to the customer is equal to the amount that the customer paid 
for this NoiseKen software. But, NoiseKen assumes no liability for any losses or 
damages incurred by the customer due to faults arising from this software by NoiseKen, 
including but not limited to, direct or indirect potential lost earnings and direct or indirect 
damages due to third party claims for compensation against the customer. 

 
4. Warranty Period 

The warranty period is the support period of the OS by the provider (including extended 
support periods) for the OS where operation is guaranteed by NoiseKen. When the 
support period of this OS ends, support for this software in this OS will also come to an 
end. 
The after service of the software ends support when the production and sales of the 
specific control equipment are discontinued. 
 

5. Exclusions 
These terms and conditions do not constitute a full and complete guarantee of operation 
or compatibility with the customer’s system. Also, the following situations are outside the 
scope of support. 
[Combining with products] 
Although every effort will be made to provide comprehensive software support, in 
combination with products other than those recommended by NoiseKen, some faults 
may be unable to be resolved due to lack of compatibility or conflicts with PCs, 
peripherals, and other hardware, and OS and other software. In addition, even in 
combination with products recommended by NoiseKen, faults may be unable to be 
resolved due to serious defects occurring in the recommended products. 
[Added functions and OS upgrades] 
Please note that support for added functions and OS upgrades are outside the scope of 
free support. 
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14. NOISE LABORATORY SUPPORT NETWORK 
 

 If a symptom which seems a trouble is found, check the symptom, software version, 

model name of connected device, and serial number, and inform this information to 

Noise Laboratory or your nearest sales agent of Noise Laboratory. 

 
 

 
 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOISE LABORATORY CO., LTD. 

1-4-4, Chiyoda, Chuo-ku, Sagamihara City, Kanagawa Pref., 252-0237, Japan 

TEL: +81-(0)42-712-2051   FAX: +81-(0)42-712-2050 

URL: http://www.noiseken.co.jp 
Printed in Japan 




